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Legal Notice  

 

 Disclaimer 

Wolters Kluwer (UK) Limited has made every effort to ensure the accuracy and 
completeness of these Release Notes.  However, Wolters Kluwer (UK) Limited, its staff and 
agents will not be liable for any errors or omissions and use of the software is subject to 
the customer’s licence with Wolters Kluwer (UK) Limited.  These Release Notes should not 
be relied upon as a detailed specification of the system or the software. 

Wolters Kluwer (UK) Limited may make changes to these Release Notes from time to time. 

 

 Copyright 

These Release Notes may not be copied, altered, edited, disposed of or distributed 
without the prior consent of Wolters Kluwer (UK) Limited. The content is confidential.  

© 2017 Wolters Kluwer (UK) Limited 

Unless indicated otherwise all other elements of this software product are owned by 
Wolters Kluwer (UK) Ltd. 

 

 Trademark Rights 

Microsoft, Windows, Windows NT, Windows for Workgroups, Windows 98, 2000, XP, MS-
DOS, Windows Vista, Windows 7, Windows 8, Windows 10, Windows Server, Microsoft 
SQL Server, and Microsoft Office, are either registered trademarks or trademarks of 
Microsoft Corporation. Novell and NetWare are trademarks of Novell Inc. Citrix 
MetaFrame is a registered trademark or trademarks of Citrix Systems, Inc. All rights 
reserved.  

All other trademarks are the property of their respective owners. 

Wolters Kluwer (UK) Limited 
145 London Road,  
Kingston Upon Thames,  
Surrey  
KT2 6SR 
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Quick Start Guide 
The Quick Start Guide is taken from the online Help on CCH Fixed Asset Register. For an in-depth 
understanding, it can be printed out, taken home and read from cover to cover. 

Other resources are: 

 the online Help which can can be accessed from any screen in Fixed Asset Register by 
pressing the F1 key. This can be more up-to-date than the Quick Start Guide. 

 free training videos which are available in the online Help under CCH Fixed Asset Register > 
Videos and Quick Start Guide. The videos provide a quick introduction and last about half an 
hour all together. 
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Introduction 
CCH Fixed Asset Register (FAR) records a business’s fixed assets and posts into both CCH Accounts 
Production and the related tax product, either CCH Corporation Tax or CCH Personal Tax. It is 
accessed through CCH Accounts Production; so it can be regarded as a module of CCH Accounts 
Production.  

Features  

 An icon for the Fixed Asset Register is visible on the Ribbon for CCH Accounts Production. 

 Data Entry is via CCH Accounts Production. When a posting is made to a Fixed Asset Register 
account, such as "Motor Vehicles Additions", you are asked whether you want to analyse the 
details of the asset (or assets) in the FAR. If you do so, you add the name of the asset, the 
depreciation method etc. 

 Alternatively you may add the details of the asset later. In this case you continue posting in 
CCH Accounts Production Data Entry. Later, when you go into the FAR using the icon on the 
Ribbon, a Reconciliation shows that the Fixed Asset Register asset balances do not agree 
with the Accounts Production nominal balances. You then add movements in the Fixed Asset 
Register until the differences come down to zero. 

 The FAR has 4 levels: 

 Asset Summary The top level is the Asset Summary screen which displays a similar level 
of detail to a fixed asset note. From here you can drill down into any Asset Class, such as 
Fixtures and Fittings or Motor Vehicles. 

 Asset Class The Asset Class screen lists the assets that comprise the Asset Class together 
with a Reconciliation of the Asset Class balances with those in the nominal ledger. From 
here you can drill down into the individual assets. 

 Asset The Asset screen shows details of the asset such as its code, name and 
depreciation method, together with a History of all the movements on the asset. From 
here you can drill down into the individual movements. 

 Asset Movement The Asset Movement screen shows the details of an individual Asset 
Movement such as its date, type, description and amount. 

 When postings in the FAR are complete, there is an option to Post Depreciation that posts 
journals back to CCH Accounts Production. 

 If CCH Corporation Tax is updated from CCH Accounts Production, the detailed Additions and 
Disposals from the FAR are imported into CCH Corporation Tax alongside the fixed asset 
totals from CCH Accounts Production. 

 Similarly, if CCH Personal Tax is updated from CCH Accounts Production, the Additions and 
Disposals from the FAR are imported into Business Tax alongside other CCH Accounts 
Production balances. 

 

Benefits  

 The CCH Fixed Asset Register allows you to maintain a record of your clients' assets alongside 
their accounts production data, saving you from maintaining separate spreadsheets. 
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 Updating the assets is quick and efficient as it can be done at the same time as CCH Accounts 
Production data entry. 

 Depreciation calculations and postings are automated, saving time in posting entries. 

 CCH Corporation Tax and CCH Personal Tax are also updated, saving you from entering the 
same information in two different applications. Extra fields required for tax processing can 
be completed in the tax application by tax staff. 
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Getting Started 

Prerequisites 

The Fixed Asset Register is a licensed product. You can see whether you are licensed in File > 

Help > About > Licensing. To use the Fixed Asset Register you also need CCH Accounts 
Production. So the prerequisites are: 

 CCH Accounts Production version 

 A licence for CCH Fixed Asset Register 

To install Fixed Asset Register, run the CSI (Central Suite Installer). The Fixed Asset Register is 
installed along with CCH Accounts Production. It is not listed separately in the CSI. 

Creating a Fixed Asset Register 

 To create a Fixed Asset Register, you need CCH Accounts Production. 

 Go into an Accounting Period in CCH Accounts Production. This is usually the first period for 
which you wish to record assets, although the Fixed Asset Register does permit prior period 
entries in some cases. 

 From the Accounts Production Home screen, click the Fixed Asset Register icon on the 
Ribbon. The option is shown below in both the Ribbon and non-Ribbon interface. 

 

 

 You are asked to select some defaults for this client: 

 Generate Asset Codes Automatically? 

 Calculate a Full Period's Depreciation in the Period of Acquisition? 

 Calculate Depreciation in the Period of Sale? 
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These defaults can be changed later on the Periods screen and are described in more detail 
later. 

 The system says "Now set up the Asset Classes for Fixtures and Fittings etc". 

 Click OK and you are taken to the Set Up screen where Asset Classes can be set up for each 
type of asset that is required on the client, e.g. for Fixtures and Fittings etc. The Asset Classes 
hold: 

 The nominal accounts that act as control accounts for the Fixed Asset Register. When 
postings are made to these accounts in CCH Accounts Production, the system asks 
"Analyse in Fixed Asset Register?" so that the posting can be broken down into its effects 
on individual assets. 

 The nominal accounts that are used for depreciation postings. 

 Defaults that are used when a new asset is set up, e.g. the Depreciation Method. 

The Asset Classes can be quickly set up using defaults from the Master Asset Classes. There is 
more detail about Asset Classes below. 

 You are now ready to start using the Fixed Asset Register. 

 

Taking on Assets 

Once the Fixed Asset Register is created, you can take on last year's closing assets. There are 
three situations. 

When the Opening Trial Balance is already present  

If the Opening Trial Balance is already present in CCH Accounts Production, then the task is to 
create the assets in the Fixed Asset Register to match the balances that have already been posted 
to the Cost B/Fwd and Depreciation B/Fwd accounts. 

1. Go into the Fixed Asset Register 

2. On the Asset Summary screen, click on the first Asset Class which should have assets added. 
The Asset Class screen opens. 

3. On the Asset Class screen, click on the New Asset icon on the Ribbon. The Asset screen 
opens. 

4. Enter the Asset Code (or accept the default), the name and Original Depreciation Method. 
Click Save. 

5. The Asset Movement screen opens. 

6. Select the Movement as Cost B/Fwd. 

7. The date defaults to the year start date. 

8. Enter the description, the Value as the cost b/Fwd and the Depreciation. Click Save 

9. You are returned to the Asset screen and can browse from there, using the Breadcrumbs, to 
take on your next asset. 

10. Continue until each Asset Class on the Asset Summary is listed with Agrees with AP as Yes. 

 When the Opening Trial Balance has not been set up  
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In this case, you will probably wish to enter the Opening Trial Balance as a journal. 

1. When the journal is posted, the system recognises the posting to one or more Cost B/Fwd 
accounts and asks "Analyse in Fixed Asset Register?" 

2. Answer Y. 

3. You can now enter the breakdown of the asset cost and depreciation brought forward as 
described above. 

When the data is available in a spreadsheet or another fixed asset register product 

In this case you will probably wish to import the assets and their Costs B/Fwd. There are two 
options to do so: 

 Import from Excel This option allows you to import assets and their Costs B/Fwd from a 
spreadsheet saved in a CSV file. The spreadsheet must be in the correct format to be 
imported. The Import from Excel is also useful if you want to import data from another fixed 
asset register system that has the ability to export data in Excel format. 

 Import from VAP This option allows users of the old VAP FAR to import assets that they have 
exported to a CSV file. 

 Both these options are documented in the Menus section. 

Buying and Selling Assets 

During the year, assets are bought and sold and the Fixed Asset Register needs to be updated. 
This topic describes some common events. 

Buying a new asset 

Buying an asset starts in CCH Accounts Production data entry, probably with a Bank Payment. 
Suppose you purchase a motor vehicle. 

1. You enter the Bank Payment in CCH Accounts Production in the usual way. 

2. The entry debits the Motor Vehicles Additions account. 

3. This account is listed on the Motor Vehicles Asset Class as the Additions account. The 
system recognises it and asks "Analyse in Fixed Asset Register?". You can answer Yes or No. 

 No If you answer No, then you can continue to your next entry in data entry, leaving 
Motor Vehicles Additions in the nominal ledger out of sync with the total of Motor 
Vehicles additions in the Fixed Asset Register. You can go into the Fixed Asset Register 
later to reconcile them. 

 Yes If you answer Yes, then a new tab opens showing the Fixed Asset Register. 

 You are taken to the Asset screen to add the new motor vehicle. Add the Asset 
and, on clicking Save, you are taken to the Asset Movement screen to create the 
Addition entry. 

 The Movement defaults to Addition. The Date, Description and Value all 
default to the values on the Bank Payment.  

 It could be that the entry does not represent a new motor vehicle. Instead it 
could be an addition to the cost of an existing motor vehicle. If so, you can 
navigate away from the new Asset screen and post the Addition on the existing 
asset. 
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 Further entries can be made in the Fixed Asset Register. But when work is 
complete, close the Fixed Asset Register tab to continue with data entry in CCH 
Accounts Production. 

Selling an asset 

Selling an asset also starts in CCH Accounts Poduction data entry, probably with a Bank Receipt. 
Suppose you sell a motor vehicle. 

1. You enter the Bank Receipt in CCH Accounts Production in the usual way. 

2. The entry credits the Motor Vehicles P/L on Disposal account. 

3. This account is listed on the Motor Vehicles Asset Class as the P/L on Disposals account. The 
system recognises it and asks "Analyse in Fixed Asset Register?" You can answer Yes or No. 

 No If you answer No, then you can continue to your next entry in data entry, leaving the 
disposal proceeds on the P/L on Disposal account in the nominal ledger out of sync with 
the disposal proceeds in the Fixed Asset Register. You can go into the Fixed Asset 
Register later to reconcile them. In this case, the P/L on Disposal account in the nominal 
ledger may relate to more than one Asset Class, but the system can still detect that the 
balances disagree with the Fixed Asset Register. 

 Yes If you answer Yes, then a new tab opens showing the Fixed Asset Register. 

 If the P/L on Disposal account  relates to only a single Asset Class then you are 
taken into that Asset Class to select the asset that was sold. On selecting the 
asset, the system automatically takes you into the Asset Movement screen to 
complete the entry. 

 If the P/L on Disposal account  relates to multiple Asset Classes, you are taken 
into the Asset Summary screen to select the Asset Class before you can select 
the particular asset. But otherwise the process is the same. 

Posting Depreciation 

There is no need to tell the system to calculate depreciation, as the system recalculates 
depreciation automatically after every Asset Movement. So after posting the Asset Movements 
for the year, you may wish to print out a Fixed Asset Report showing the calculated cost and 
depreciation for all assets for the year. The option is Asset Summary > FAR Report. 

The next step is to post the depreciation entries back to CCH Accounts Production. The option is 
Asset Summary > Post Depreciation. 

For each Asset Class, Post Depreciation generates up to 3 journals: 

1. Depreciation Journal Debits: P&L account for Depreciation Charge. Credits: B/S account 
for Depreciation Charge. This entry represents the depreciation for the year. 

2. Revaluation Journal Debits: Depreciation on Revaluation. Credits: Revaluation Reserve. 
This entry eliminates the depreciation which has been charged to date on the asset that has 
been revalued. From this point depreciation will be calculated on the revalued amount. 

3. Profit/Loss on Disposal Journal Credits: Asset Cost of Disposals. Debits: Depreciation on 
Disposal. Debits: P/L on Disposal. This entry eliminates the cost and depreciation that has 
been charged to date on the asset, leaving both the cost and depreciation to be carried 
forward as zero. 

Notes 
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 If Post Depreciation is rerun, the previously generated entries are replaced with newly 
calculated entries. For this reason the user should not edit entries generated by the Fixed 
Asset Register. 

 The nominal accounts that are used for these postings are set up on the Asset Classes on the 
Set up screen. 

 After running Post Depreciation, you may click on the Accounts Production tab to see the 
effect of the postings. The  data in the Accounts Production tab is not immediately refreshed 
and you will still see the data from before posting depreciation. You need to click away to 
another screen in Accounts Production, e.g. the Trial Balance screen, to see the effect of the 
postings. 

Updating Corporation Tax 

Overview 

The Tangible Fixed Assets area of CCH Corporation Tax shows the totals of the fixed asset note 
from the accounts and there are screens to itemise the Additions and Disposals that make up the 
these totals. There is a panel that reconciles the detailed Additions and Disposals to the Tangible 
Fixed Assets totals. The Additions and Disposals are allocated to pools and are used to calculate 
Capital Allowances. The Tangible Fixed Assets area of Corporation Tax is shown below with links 
to the Additions and Disposals. 

 

When CCH Accounts Production is in use, the data in the Tangible Fixed Assets area can be 
imported into Corporation Tax from Accounts Production and the Fixed Asset Register: 

 CCH Accounts Production data comes from the fixed asset note in the accounts. This 
accounts page supplies the headings and the totals shown in the Tangible Fixed Assets 
screen above. 

 CCH Fixed Asset Register supplies the detailed Additions and Disposals. 

This topic discusses how the link from Fixed Asset Register to Corporation Tax is set up and run. 
The areas discussed are: 

 Setting Up the Tax Links screen This explains how the link between Fixed Asset Register and 
Corporation Tax is set up. 
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 Exporting the data from Accounts Production explains how data is exported from Accounts 
Production into a "holding area" before it can be imported into Corporation Tax. 

 Importing the data into Corporation Tax explains how the data can be brought from the 
"holding area" into Corporation Tax. 

 Editing Additions and Disposals in Corporation Tax explains how extra tax data can be added 
to Additions and Disposals in Corporation Tax after they have been imported from Fixed 
Asset Register. 

Setting up the Tax Links screen 

The Tax Links screen appears when you open a limited company client. It is used to specify what 
data is brought into CCH Corporation Tax from CCH Accounts Production and the Fixed Asset 
Register. 

 

The settings are as follows: 

 Update automatically Corporation Tax is automatically updated from CCH Accounts 
Production when a Period of Account is opened without needing to click Update from 

Accounts. 

 CCH Accounts Production link - Balance sheet If this option is ticked then Fixed Asset 
Register data is imported into Corporation Tax along with other Balance Sheet data. This 
setting can be different for each Period of Account. If it is not ticked, then the Fixed Asset 
Register is "unlinked" from Corporation Tax. This means that no data is imported from the 
Fixed Asset Register into Corporation Tax. It also means that any data previously imported, 
i.e. when it was linked, can be freely edited. 

Notes 

 Although Update automatically causes the data to be read automatically into Corporation 
Tax, it still needs to be exported from CCH Accounts Production into a holding area first. 

 The settings CCH Accounts Production link - Profit & Loss, CCH Accounts Production link - 

Basic, Update primary trade and CCH Accounts Production link - Balance sheet affect 
what data is imported from Accounts Production and are described in the Corporation Tax 
Help. 
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 There are some differences between how the Tax Links screen is used with the Fixed Asset 
Register and how it is used for other data in CCH Accounts Production. These are explained 
in the Reference section. 

Exporting the data from Accounts Production 

The Fixed Asset Register data is imported into Corporation Tax alongside the Accounts Production 
data. Accounts Production data must be exported into a "holding area" before it can be imported 
into Corporation Tax. To import Fixed Asset Register data you must export the Accounts 
Production data first. Otherwise the system will report that there is "Nothing to import". 

To export the data from Accounts Production: 

 Go into the relevant Accounting Period in Accounts Production 

 Click Tax Link followed by Update Tax on the Ribbon 

 The system asks "Mark the Tax Link data as Draft?" This question has no effect when 
exporting to Corporation Tax. Answer No and click Continue. 

 The system reports "Update complete". 

The Accounts Production Tax Link screen is shown below. 

 

Notes 

 On the screen above the Tax Link option is highlighted and Update Tax is shown on the 
Ribbon. 

 The right hand part of the screen shows what is called the "Basic Profit and loss data" but 
this is not relevant to the export of Fixed Asset Register data. 
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Importing the data into Corporation Tax 

How data is imported into Corporation Tax depends on whether Update automatically is ticked 
on the Tax Links screen above. 

 If Update automatically is ticked, then the Accounts Production data and Fixed Asset 
Register data are imported as soon as the user goes into the Period of Account. 

 If Update automatically is not ticked then you can either click Update from Accounts in the 
Ribbon or click the warning in the Errors and Exceptions panel that "CCH Accounts 
Production information has changed and is available..." Both options are highlighted below. 

 

Notes 

 The warning in the Errors and Exceptions panel can also appear if Update automatically is 
ticked. This happens if you have both Accounts Production and Corporation Tax open at the 
same time. If you click Update Tax in Accounts Production then the warning immediately 
appears in Corporation Tax saving you from exiting Corporation Tax and going back in to 
import the new data. 

 You may notice that the Fixed Asset Register icon is visible in Corporation Tax. It is enabled 
when you are in the Tangible Fixed Asset area and allows you to go into the Fixed Asset 
Register directly from Corporation Tax. 

Editing Additions and Disposals in Corporation Tax 

Once Additions and Disposals have been imported into Corporation Tax from the Fixed Asset 
Register there is further data that tax personnel need to add to the records. The screen below 
shows a single Addition that has been imported from Fixed Asset Register. 
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Notes 

 Some fields come from the Fixed Asset Register, such as the asset Description. These fields 
are greyed out and disabled. To change them you need to update the Fixed Asset Register. 

 Some fields, such as Tax Value and Pool Type, do not exist in the Fixed Asset Register. These 
are enabled and you can complete them in Corporation Tax. 

 The last field shows Updated from FAR to indicate that this Addition has been imported 
from the Fixed Asset Register. 

 The Balance Sheet category field is a special case. It comes from the asset's Asset Class. If 
the Balance Sheet category in the Fixed Asset Register matches the heading of one of the 
columns of the Tangible Fixed Assets screen, then the field is disabled. In the example above 
the Balance Sheet category in the Fixed Asset Register is "Fixtures and Fittings". This matches 
a column heading in the Tangible Fixed Asset screen (which in turn came from the text on 
the fixed asset note in the accounts). So the field is disabled. But if the Balance Sheet 
category does not match then the field is enabled and you can select it in a drop down. 

 If you make changes in Corporation Tax and then reimport the data from the Fixed Asset 
Register, your changes are not lost. When the new records are imported, the fields that 
came from the Fixed Asset Register are updated and your changes are retained. 

 Although the Fixed Asset Register fields on each entry are usually disabled in Corporation 
Tax, there is a way around this. If you "unlink" the Fixed Asset Register from Corporation Tax, 
no further changes are imported from the Fixed Asset Register and the data that is already 
present in Corporation Tax becomes fully editable. To unlink the Fixed Asset Register, untick 
CCH Accounts Production link - Balance sheet for the relevant period of account on the 
Tax Links screen. 

 Editing Disposals is done in the same way as editing Additions. 

Updating Personal Tax 

Overview 

The Business Tax area of CCH Personal Tax has a screen summarising the Accounting Period 
balances. The screen is accessed by selecting Business Tax, clicking the link for the Business and 
clicking the link for the Accounting Period. 
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When CCH Accounts Production is in use, data can be imported from Accounts Production and 
the Fixed Asset Register into the tabs on the Accounting Period screen: 

 CCH Accounts Production supplies the data for the Income, Expenses and Balance Sheet 
tabs. 

 CCH Fixed Asset Register supplies the detailed Additions and Disposals which are accessed 
through the Capital Allowances tab. 

You can also go directly into the Fixed Asset Register from Personal Tax using the Fixed Asset 

Register icon which is highlighted above and is available from 2017 onwards. 

This section discusses how the link from Fixed Asset Register to Personal Tax is set up and run. 
The areas discussed are: 

 Setting Up the Tax Links screen This explains how the link between Fixed Asset Register and 
Personal Tax is set up. 

 Exporting the data from Accounts Production This explains how data is exported from 
Accounts Production into a "holding area" before it can be imported into Personal Tax. 

 Importing the data into Personal Tax This explains how the data can be brought from the 
"holding area" into Personal Tax. 

 Allocating Additions and Disposals in Personal Tax to an Asset/Pool type This explains how 
Additions and Disposals that have been imported into Personal Tax need to be allocated to 
the correct Asset/Pool types using the Business Tax Movements screen. 

 Movements screen This explains how the Business Tax Movements screen is used with 
imported Additions and Disposals. 

Setting up the Tax Links screen 

The Tax Links screen appears when you open a personal, partnership or trust client. It is used to 
specify what data is brought into CCH Personal Tax from CCH Accounts Production and the Fixed 
Asset Register. 
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The settings are as follows: 

 Update automatically - CCH Accounts Production Personal Tax is automatically updated 
from Accounts Production when a Tax Return is opened without needing to click Update 

from Accounts. 

 CCH Accounts Production link If this option is ticked then Fixed Asset Register data is 
imported into Personal Tax along with Accounts Production data for years 2017 onwards. 
This setting can be different for each tax year. If it is not ticked, then the Fixed Asset Register 
is "unlinked" from Personal Tax. This means that no data is imported from the Fixed Asset 
Register into Personal Tax. It also means that any data previously imported, i.e. when it was 
linked, can be freely edited. 

 Allow draft accounts When data is exported from Accounts Production, you must specify 
whether the data is Draft or Final. If you select Draft then Allow draft accounts must be 
ticked to allow it to be imported into Personal Tax. 

Notes 

 Although Update automatically causes the data to be read automatically into Personal Tax, 
it still needs to be exported from Accounts Production into a holding area first. 

 The other settings on the Tax Links screen are described in the Personal Tax Help. 

 There are some differences between how the Tax Links screen is used with the Fixed Asset 
Register and how it is used for other data in CCH Accounts Production. These are explained 
in the Reference section. 

Exporting the data from Accounts Production 

The Fixed Asset Register data is imported into Personal Tax alongside the Accounts Production 
data. Accounts Production data must be exported into a "holding area" before it can be imported 
into Personal Tax. To import Fixed Asset Register data, you must export the Accounts Production 
data first. Otherwise the system will display no CCH Accounts Production periods ready to import. 
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To export the data from Accounts Production: 

 Go into the relevant Accounting Period in Accounts Production 

 Click Tax Link followed by Update Tax on the Ribbon 

 The system asks "Mark the Tax Link data as Draft?" Draft data can only be imported if Allow 

draft accounts is ticked on the Tax Links screen. Answer appropriately and click Continue. 

 The system reports "Update complete". 

The Accounts Production Tax Link screen is shown below. 

 

Notes 

 On the screen above the Tax Link option is highlighted and Update Tax is shown on the 
Ribbon. 

 The right hand part of the screen shows the Accounts Production balances that are exported 
to Personal Tax, but this is not relevant to the export of Fixed Asset Register data. 

Importing the data into Personal Tax 

How data is imported into Personal Tax depends on whether Update automatically is ticked on 
the Tax Links screen that was described above. 

 If Update automatically is ticked, then the Accounts Production data and Fixed Asset 
Register data are imported as soon as the user goes into the Tax Return. 

 If Update automatically is not ticked, then you can either: 

 Select Business Tax, select the Accounting Period and click Update from Accounts in the 
Ribbon. 

 Click the warning in the Errors and Exceptions panel that "CCH Accounts Production data 
is available..." This option is shown in the screen below. 
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 If data has been exported from multiple accounting periods, you are requested to select the 
period to import. 

 The Accounts Production data and any Fixed Asset Register data is imported. 

Notes 

 The warning in the Errors and Exceptions panel can also appear if Update automatically is 
ticked. This happens if you have both Accounts Production and Personal Tax open at the 
same time. If you click Update Tax in Accounts Production then the warning immediately 
appears in Personal Tax saving you from exiting Personal Tax and going back in to import the 
new data. 

 Further details are available about importing data in the online Help under CCH Personal 

Tax > Linking Products > Updates from CCH Accounts Production. These cover the case 
where the CCH Accounts Production period does not match the Accounting Period set up in 
Personal Tax or where multiple Accounts Production clients are linked to a single Personal 
Tax return. 

Allocating Additions and Disposals in Personal Tax to an Asset/Pool type 

Once the Additions and Deductions have been imported, the system checks whether there are 
any new movements that have not been imported previously. If there are, the Errors and 
Exceptions panel shows the message “Some Fixed Asset Register movements have not yet been 
allocated to an Asset/Pool type”. 
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If there are unallocated movements: 

 Click on the message to go into Business Tax 

 Select the business and then the Accounting Period 

 Click on the Capital Allowances tab and click any of the links to allowances, e.g. Annual 
Investment Allowance which is the first link. 

 A list of Asset/pool types is displayed. 

 

 A new Asset/pool type is listed called “Movements not allocated to any asset/pool type” 
with a Description of Unallocated.  

 The Unallocated pool is created automatically by the system when there are any unallocated 
movements. If it appears, you need to allocate these movements as follows. 

 Click the Unallocated link. This opens the pool. The only enabled button is called 
Movements. 

 Click the Movements button. The Movements screen appears. 

Movements screen 

The Movements screen has extra columns when the Personal Tax client is linked to a Fixed Asset 
Register client. These columns allow imported movements to be allocated to the correct 
Asset/Pool type.  
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For imported movements, fields that come from the Fixed Asset Register, such as the asset 
Description, are greyed out and disabled. To change them, you need to update them at source in 
the Fixed Asset Register. The fields that do not exist in the Fixed Asset Register, such as the 
Asset/Pool Type, are completed in Personal Tax. These are as follows: 

 Asset/Pool type This column is used to allocate the imported movement to the correct 
Asset/Pool type. 

 Movement For imported movements, this column is set to “Additional Acquisition” for an 
Addition or “Part/pool disposed” for a Disposal. However the user may need to edit it to a 
different Movement such as “Acquisition not qualifying for AIA” or “Initial acquisition” for 
the first acquisition in a particular Asset/Pool type. 

In addition, a link is available when the Personal Tax client is linked to a Fixed Asset Register 
client. 

 Click here to create a new asset or pool This link is used to create a new asset/pool type. 
Once added, it is available in the dropdown for the Asset/Pool type without leaving the 
Movements screen. 

Notes 

 Once a movement has been allocated to a different Asset/Pool type, it disappears from the 
Movements screen as soon as you move to a different row on the screen. This can be a little 
disconcerting! If you need to make further changes to the movement, go into the Asset/Pool 
type to which the movement was allocated and click its Movements button. But it is easier to 
make all the changes you need for a movement before moving to a different row. 

 The column Is Updated from FAR? is ticked for Movements that have been imported from 
the FAR. 

 For Asset/Pool types other than the Unallocated pool, you can add movements manually in 
the usual way. If the PT client is linked to a FAR client, then the columns for Asset/Pool type 
and Is Updated from FAR? appear but are disabled. 

 If an imported movement is allocated to the wrong Asset/pool type, you can go into the 
Asset/Pool type to which it was allocated and reallocate it to the correct Asset/Pool type. 

 If you make changes to an imported movement in Personal Tax and then reimport the data 
from the Fixed Asset Register, your changes are not lost. When the new records are 
imported, the fields that came from the Fixed Asset Register are updated and your changes 
are retained. 

 Although the Fixed Asset Register fields on each entry are usually disabled in Personal Tax, 
there is a way around this. If you "unlink" the Fixed Asset Register from Personal Tax, no 
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further changes are imported from the Fixed Asset Register and the data that is already 
present in Personal Tax becomes fully editable. To unlink the Fixed Asset Register, untick 
CCH Accounts Production link for the relevant tax return on the Tax Links screen. 

 Disposals are imported and edited in the same way as Additions. But if there is an Addition in 
the same year as the Disposal, then the Addition is ticked as Disposed in Year? and the 
Disposal is not imported. 

 When all unallocated movements have been allocated, the Unallocated pool is automatically 
deleted.  

Year End 

No special process is required in the Fixed Asset Register to perform a year end. You just perform 
a Year End in CCH Accounts Production in the usual way. The system does not let you proceed if 
either: 

 The nominal ledger does not reconcile with the Fixed Asset Register, or 

 An Asset Movement has been made in the Fixed Asset Register since last Posting 
Depreciation. 

Notes 

 Although the system warns you at Year End if the nominal ledger does not reconcile or if 
depreciation needs to be posted, note that: 

1. It does not warn you at other times, such as when printing a set of accounts. 

2. CCH Accounts Production and the FAR both allow you to make entries in the earlier 
Accounting Period which stop the earlier period reconciling. To prevent this you can 
Finalise the CCH Accounts Production using the option on the Ribbon on the Home 
screen.   
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Menus 

Asset Summary 

The Asset Summary is the first screen to appear on accessing the Fixed Asset Register from its 
icon. It lists the client Asset Classes and their balances for the year. It also has Ribbon options for 
important functions within the Fixed Asset Register. 

 

The columns are: 

 Code and Name The code and description of the Asset Class, e.g. FF Fixtures and Fittings. 
Click on the Asset Class to see more detail. 

 Balance Sheet Category The description used on CCH Accounts Production's fixed asset note 
for this Asset Class. Assets brought into Corporation Tax are grouped by Balance Sheet 
Category. For instance, there could be Asset Classes in the FAR for "Freehold Property" and 
"Leasehold Property", but both Asset Classes could be aggregated as "Land and Buildings" on 
the fixed asset note. In this case both Asset Classes would have a Balance Sheet Category of 
"Land and Buildings". 

 Agrees with AP The balances on the assets in the Asset Class agree with the nominal 
accounts in CCH Accounts Production. A single nominal account can be used on multiple 
Asset Classes, e.g. several Asset Classes could use the same Profit and Loss on Disposal 
account. In this case, the FAR agrees with the nominal ledger if the nominal account agrees 
with the sum of the FAR balances across all the Asset Classes that use it. 

 Remaining columns The balances shown are similar to those for a fixed asset note for the 
current year. To see the balances for a different year, exit the FAR and choose a different 
Accounting Period in CCH Accounts Production. 

Ribbon  

The options are: 

 Export Export the Asset Summary to Excel, from where it can be printed if required. 
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 Periods Use this option to specify the options such as "Calculate Depreciation in the Year of 
Acquisition" that can be set by Accounting Period. 

 Set up Used to set up the Asset Classes and the nominal accounts that each class uses. 

 Post Depreciation Posts depreciation journals back to CCH Accounts Production. 

 FAR Report Used to list all assets with their cost and depreciation for the year.  

 Import from Excel Used to import asset balances from a spreadsheet or another FAR 
system. 

 Import from VAP Used to import asset balances from the legacy VAP FAR. 

Periods 

The Periods screen is used to specify options such as Calculate a Full Period's Depreciation in 

the Period of Acquisition? that can be set for each Accounting Period. 

 

There are two types of Accounting Period: 

 Accounting Periods that are linked to CCH Accounts Production. All Accounting Periods in 
CCH Accounts Production are automatically included  on the Periods screen. The dates of 
these periods cannot be amended in the FAR. 

 Accounting Periods that are not linked to CCH Accounts Production. Extra Accounting 
Periods can be set up that exist only in the FAR and are not linked to CCH Accounts 
Production. This can be useful if the history of the fixed assets needs to go back further than 
the Accounting Periods in CCH Accounts Production. These periods can also be created 
automatically if a CCH Accounts Production Accounting Period is deleted; this leaves behind 
a FAR Accounting Period that is not linked to CCH Accounts Production. 

The columns are: 

 Start Date and End Date If the Accounting Period is linked to AP then these cannot be 
edited. The system ensures that there are no gaps between periods. 

 Exists in AP Indicates that the Accounting Period is linked to AP. It is set by the system and 
cannot be edited. 

 Finalised If the Accounting Period is linked to AP then this is the same as AP's Finalised 
indicator. If not, then this can be ticked to finalise a period. No further changes can be made 
in the FAR to a finalised Accounting Period without unticking this check box first. 
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 Generate Asset Codes Automatically? If ticked, then the system generates the code for new 
assets automatically. If the asset belongs to Asset Class MV (for Motor Vehicles) then the 
first asset is given the code MV00001, the second MV00002 etc. 

 Calculate a Full Period's Depreciation in the Period of Acquisition? If an asset is bought in 
the middle of an Accounting Period a full year's depreciation is calculated for it, instead of 
calculating just from the date of acquisition. This is a common accounting treatment. 

 Calculate Depreciation in the Period of Sale? If this setting is unticked then no 
depreciation is calculated in the year of sale. This is a common accounting treatment. 

Notes 

 If you perform a Year End in CCH Accounts Production and then go into the Fixed Asset 
Register, a new Accounting Period is created automatically in the Fixed Asset Register 
mirroring the period in AP. The settings for the new period are copied from the previous 
period. So after a Year End in AP there is usually no need to go into Periods in the FAR. 

 Because each Accounting Period has its own settings, it is possible to change these settings 
at the year end if there is a change of accounting treatment. 

 If you buy and sell an asset in a single year, then the Period of Acquisition and of Sale are the 
same period. If Calculate Depreciation in the Period of Sale? is unticked, the system does 
not calculate depreciation, even if Calculate a Full Period's Depreciation in the Period of 

Acquisition? is ticked. 

Set Up 

The Set Up screen is used to set up the client's Asset Classes such as Fixtures and Fittings or 
Motor Vehicles. Every Asset must belong to an Asset Class. 

 

 The Asset Class provides: 

 The nominal accounts that act as control accounts for the Fixed Asset Register. When 
postings are made to these accounts in CCH Accounts Production, the system asks "Analyse 
in Fixed Asset Register?" so that the posting can be broken down into its effects on individual 
assets. 

 The nominal accounts that are used for depreciation postings. 

 Defaults that are used when an asset is set up, e.g. the Depreciation Method. 

The columns are as follows: 

 Code The code of the Asset Class, e.g. FF for Fixtures and Fittings. 

 Name The name of the Asset Class, e.g. Fixtures and Fittings.  

 Balance Sheet Category The description used on CCH Accounts Production's fixed asset note 
for this Asset Class. Assets brought into Corporation Tax are grouped by Balance Sheet 
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Category. For instance, there could be Asset Classes in the FAR for "Freehold Property" and 
"Leasehold Property", but both Asset Classes could be aggregated as "Land and Buildings" on 
the fixed asset note. In this case both Asset Classes would have a Balance Sheet Category of 
"Land and Buildings". 

 Nominal Accounts The next 11 columns are for nominal accounts. These are selected in the 
same way as in CCH Accounts Production. You can enter a word from the account name and 
all matching accounts are displayed. For instance, you can enter "motor" and all motor 
vehicle accounts are displayed. Alternatively, enter the first few digits of the accounts code 
and all matching nominals are displayed. The nominal accounts cannot be overridden on 
individual Assets. 

 Depreciation Method This is None, Straight Line or Reducing Balance. It can be overridden 
on individual Assets. 

 Depreciation Percentage Like the Depreciation Method, this is a default that can be 
overridden on individual Assets. 

The screen has one button: 

 View Master Asset Classes The Master Asset classes hold defaults to speed up setting up the 
Asset Classes. They are explained in the Notes below. 

Notes 

 Every client with a Fixed Asset Register needs Asset Classes set up. They are usually set up 
once and do not need to be altered in subsequent years unless the client buys a new type of 
asset. 

 When you click on the Code field to add a new Asset Class, the system asks "Create from a 
Master Asset Class?" If you answer Yes, then the Master Asset Class can be selected. The 
Master Asset Class has default nominal accounts already set up. This saves you from having 
to select all the nominal accounts each time an Asset Class is set up. 

 The Asset Classes are saved at client level. So whichever Accounting Period you go into for a 
client, you see the same Asset Classes. However if a client converts to FRS102, then the 
nominal accounts on the Asset Class are invalid in the new year. If this happens, then you are 
warned when you first open the Fixed Asset Register in the new year and you are taken into 
the Set Up screen to correct the Asset Classes for the new year. This is a little laborious as 
the Master Asset Classes only speed up adding a new Asset Class; there is no way to speed 
up editing an existing Asset Class. 

 More detail on the Usage of the Asset Class Nominals can be found in the Reference section. 

Master Asset Classes 

The Master Asset Classes provide defaults for setting up Asset Classes at client level. The columns 
are the same as those for the client Asset Classes. 

Notes 

 The Master Asset Classes are part of the CCH Accounts Production versioning system. This 
means that CCH ship values that relate to the CCH chart of accounts for each entity. These 
CCH Master Asset Classes cannot be edited. 

 However if the user creates a new Practice Master Pack then the Master Asset Classes can 
be edited. Most users do not do this. 
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 Although the Master Asset Classes cannot usually be edited, the Asset Classes that are 
created on each client can be edited as the Master Asset Classes only provide defaults for 
setting up the client Asset Classes. 

 The Master Asset Classes are usually accessed through the Set Up screen, but they can also 
be accessed through File > Maintenance > Accounts > Master Asset Classes. 

FAR Report 

The FAR Report lists all assets showing their cost and depreciation for the year. 

 There are two versions of the FAR Report: 

 The Summary style report shows the key balances with just one line per asset. The 
details shown include the NBV b/fwd and c/fwd, the acquisition date, the profit/loss on 
sale and the depreciation method. But the Cost and Depreciation b/fwd and c/fwd are 
not shown, and nor are the Revaluation balances. 

 The Fixed Asset Note style shows columns that are similar to those on a fixed asset note. 
These include the Cost and Depreciation b/fwd and c/fwd and the Revaluation balances, 
but not the NBV b/fwd and c/fwd. With this style of report, there is an option to Show 

asset details. If ticked, then two extra lines are included for each asset showing: 

 The asset’s acquisition and disposal dates 

 The asset’s depreciation method. 

 The report is produced on screen 

 There are options to Print, Export to PDF and Export to Excel. 

Import from Excel 

Assets and their costs can be imported from Excel. This is useful for importing data from: 

 Spreadsheets that have been used to record fixed assets. 

 Other fixed asset register systems that have the ability to export data in Excel format. 

CSV File Layout 

To import assets and their costs, the Excel spreadsheet must be saved in CSV format. A CSV file is 
an Excel spreadsheet saved without its formulae and formatting, but retaining its values. A CSV 
file can be viewed in either Excel or Notepad. 

To create a CSV file from an Excel spreadsheet, proceed as follows: 

 Select File > Save As and choose the location to save the file. 

 When requested for the file name, enter it and select the Save as type as “CSV (Comma 
delimited) (*.csv)”. 

 Click Save. The system warns that some features may be lost and asks whether you want to 
keep using that format. Say Yes to save the file. 

A sample CSV file opened in Notepad is shown below: 

A,FF01,Lights,FF,,,,,1,01/01/2015,,Cost b/fwd imported asset,1000,200 

A,FF02,Boardroom table,FF,,S,10,0,1,01/01/2015,,Cost b/fwd imported asset,2000,400 

Notes 
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 The columns in a spreadsheet are represented by commas in the CSV file. Two consecutive 
commas indicate an empty column in the spreadsheet. 

 Each line creates a new Asset and a Cost B/Fwd movement. 

 Each line has the columns shown below. The validation rules for each field are the same as 
those for manual data entry for the Asset and the Asset Movement. 

 

Column Field name Description 

1 Row type Always A for Asset. This allows Wolters Kluwer to add 
other row types in the future if required. 

2 Asset Code If the FAR Accounting Period has the option set for 
Generate Asset Codes Automatically then this field is 
optional. Otherwise an Asset Code must be specified. 

3 Asset name Mandatory 

4 Asset class code Mandatory 

5 Depreciation start 
date 

Usually blank 

6 Depreciation 
method 

Optional. S/R/N if specified, for Straight line/Reducing 
balance/None. If omitted, the default is taken from 
the Asset Class. 

7 Percentage Optional. If omitted, the default is taken from the 
Asset Class. 

8 Residual value Optional. If omitted and the Depreciation Method is 
Reducing Balance then the system supplies a Residual 
Value of 1. 

9 Movement type Always 1 for Cost B/Fwd. This allows Wolters Kluwer 
to add other types in the future if required. 

10 Date Mandatory. The date of a Cost B/Fwd is usually the 
first date of the accounting period. 

11 Acquisition date Optional 

12 Description Optional 

13 Value Mandatory 

14 Depreciation Mandatory, although the amount can be 0 

Import from Excel screen 



VERSION 2017.2 - AUGUST 2017 26 

The Import from Excel screen is as follows. 

 

Fields 

 File to Import Click the ellipsis to browse to the CSV file to import. The lines of the file are 
displayed in the grid. If the line is invalid, an error is displayed in the Error column. 

 Has headers Tick the checkbox if the CSV file has any header lines before the first asset and 
enter the number of lines in the box to the right. Header lines are ignored by the Import. 

 Show invalid only Tick this to remove the valid lines from the grid so that only the errors are 
displayed. This is useful when there are a large number of lines but only a few errors. 

 Import This button causes the assets to be imported. It is only enabled if all the lines in the 
CSV file are valid. 

Usage 

1. Click the ellipsis of File to Import to browse to the CSV file to import. The lines of the file 
are displayed in the grid. If the line is invalid, an error is displayed in the Error column. 

2. A validation message is displayed: 

 If there are no errors, the message could read: “10 entries found. 0 errors. Click the 
Import button if you want to import the data”. 

 If there is an error in one or more lines, the message could read: “10 entries found. 3 
errors. Use Print or Export to list the errors. Correct them in the CSV file and try again.” 

3. Note that the data cannot be imported until it is all valid. 

4. If the file has header lines, click Has Headers and enter the number of header lines. The 
grid is redrawn and the validation message is displayed again. 

5. When the data is all valid, click Import to import the assets. 

6. After importing the data, you are returned to the Asset Summary screen. 

Import from VAP 

Assets and their costs can be imported from the old CCH VAP Fixed Asset Register. The process is 
very similar to the Import from Excel. It follows these steps: 
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 The VAP fixed asset data is exported from the VAP FAR into a CSV file. 

 In Central, you go into a client’s Fixed Asset Register and select Import from VAP. The 
process works the same way as importing from Excel except that the system ignores assets 
that have been sold in VAP and the VAP Asset Classes need to be mapped to the FAR Asset 
Classes. 

These steps are discussed in the following two sections. 

Note that the Import from VAP imports all assets for a client in one operation. If any assets 
already exist on the client in Central, they are deleted first. Whereas the Excel Import can be 
performed incrementally with further imports adding more assets. 

Copying Data from the VAP FAR into a CSV File 

The first step in converting VAP Fixed Asset Register data to the new FAR is to copy the VAP data 
into a CSV file which is created via Excel. To do this, proceed as follows: 

 Go into the client in VAP. 

 Select Ledgers > Fixed Asset Register. 

 A list of the assets appears. Ensure that depreciation has been calculated for the year. 

 Select Fixed Assets > Drag Mode. 

 A message appears, “This will allow you to drag row(s) into a Microsoft Excel Spreadsheet.” 
Click OK. 

 Open a new Excel spreadsheet. 

 On the screen, position VAP and Excel so that both are visible at once. This may involve using 
the Restore icon in the top right of the VAP and Excel windows and resizing both applications 
to fit next to each other. 

 

 In VAP FAR, click the first asset. Then press Shift-Down arrow to extend the list of selected 
assets down to the last one. All the assets should be highlighted. 

 Drag the highlighted assets to the Excel spreadsheet. All the assets should now appear in the 
spreadsheet. The screen appears as follows: 
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 If the asset codes are numeric, Excel will reformat them without the leading zeroes. In Excel 
the leading zeroes can be added back as follows: 

 Highlight the first column by clicking the “A” in the column heading. 

 Right click > Format cells. Select the Number tab. Then Custom. 

 Enter Type as 0000 where the number of zeroes is the number of digits required in the 
asset code. 

 Press Return and the column should now appear correctly. 

 Select File > Save As and choose the location to save the file. 

 When requested for the file name, enter it and select the Save as type as “CSV (Comma 
delimited) (*.csv)”. 

 Click Save. The system warns that some features may be lost and asks whether you want to 
keep using that format. Say Yes to save the file. 

Note 

 If you have difficulty following these steps, please see the video on it in Videos and Quick 
Start Guide in the online Help. 

Importing the VAP CSV file into the Fixed Asset Register 

The procedure is as follows: 

1. Go into Accounts Production in the financial year after the VAP financial year. This is 
because the balances imported from VAP will form the Costs B/Fwd for the next year in the 
FAR. 

2. If there are already any assets present on the client, the warning is given “Assets already exist 
for this client. To import assets from VAP these must all be deleted. Do you wish to delete all 
assets on this client?” If you answer Yes all assets on the client are deleted. Obviously select 
this option with care. It is only intended to be used if you have imported a lot of assets into 
the wrong accounting period. Using this option makes it possible to delete the previously 
imported assets and import them into the correct period.  

3. The screen for Import from VAP appears. It works in the same way as the Import from Excel 
screen, with the following exceptions: 

 The option Has Headers is ticked and 1 header line is selected, as this is the format of the 
VAP CSV file. 

 The VAP data includes a column for Disposal Date. If an asset has been sold it is marked 
as “Asset sold” in the Error column. This means that the asset will not be imported, but it 
is not strictly an error as you can still import the VAP assets that have not been sold. 

4. On clicking Import, you are requested to enter the FAR Asset Class code corresponding to 
each VAP Asset Class. 

 The VAP Asset Classes are called Control Groups and the Control Group codes are called 
Group Detail Codes. In VAP FAR you can see them by clicking the Control Groups icon. 



29  VERSION 2017.2 – AUGUST 2017 

 

 On clicking Import, you enter the FAR Asset Class for each Group Detail Code. 

 

 Note that you may need to consult the VAP FAR to see what each Group Detail Code 
represents. 

5. The assets are then imported with a Cost B/Fwd entry dated on the first day of the financial 
year selected at step 1. 

6. After importing the data, you are returned to the Asset Summary screen. 

Asset Class 

The Asset Class screen lists the assets that make up the Asset Class and a shows a Reconciliation 
with the nominal ledger balances. The screen has two sections. 
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FAR Balances  

The FAR Balances section occupies the top half of the screen and lists the assets in the Asset 
Class. The columns are: 

 Code and Name The code and description of the Asset, e.g. FF00001 Boardroom chairs. Click 
on the Asset  to see more detail. 

 Remaining columns The balances shown are similar to those for the Asset Summary. 

Reconciliation  

The Reconciliation section occupies the bottom half of the screen. The purpose of the 
Reconciliation is to show whether the nominal account balances agree with the balances on the 
Fixed Asset Register. The system checks the 5 nominal accounts that act as "trigger accounts". 
Posting to these accounts in CCH Accounts Production triggers the question "Analyse entry in 
Fixed Asset Register?". There are two main reasons why these accounts might not reconcile: 

1. If you choose not to analyse a CCH Accounts Production entry in the FAR immediately. 

2. If you go into the Fixed Asset Register directly and post a FAR entry with no matching entry 
on the nominal ledger. 

It is also possible that other nominal accounts will not match the Fixed Asset Register, e.g. the 
Depreciation Charge P&L account, but the Reconciliation does not check these. This is discussed 
further in a FAQ. 

There are columns for the five nominal accounts that are reconciled. The rows are: 

 Nominal Ledger This is the balance on the nominal account, except for the last column, 
Disposal Proceeds. The Nominal Ledger figure for Disposal Proceeds shows the total of the 
amounts posted manually to the P/L on Disposal account - these are assumed to be the 
Disposal Proceeds. Amounts posted by the Fixed Asset Register automatically are excluded, 
i.e. the cost and depreciation eliminated on disposal. 

 Fixed Asset Register These are the FAR balances corresponding to these five accounts. The 
Additions balance includes both Additions and Adjustment Movements posted during the 
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year. Usually the Fixed Asset Register balances on this row agree with those shown above in 
the FAR Balances section of the screen. But if two or more Asset Classes share the same 
nominal account, e.g. for the P/L on Disposal, then the Reconciliation shows the total 
balance for all the Asset Classes that use it, not just for the one Asset Class shown in the FAR 
Balances section. 

 Difference The differences between the two rows. 

 Nominal Code This is the nominal code for the balance shown. You can drill into the nominal 
code to see the underlying nominal ledger entries. 

Note 

 If all five differences are zero then Agrees with AP is Yes on the Asset Summary screen. 

 Ribbon  

The options are: 

 Export Export the Asset Class to Excel, from where it can be printed if required. 

 Delete Asset Class An Asset Class can only be deleted if it contains no assets. 

 New Asset Creates a new asset. 

Asset       

The Asset screen shows details of the asset. 

 

The Asset screen details apply to all years, not just the Accounting Period that is currently 
selected in CCH Accounts Production. This fact imposes some restrictions on what changes can be 
made. Changes cannot be made if they affect an earlier period that has been finalised. Also if 
they affect an earlier period that has not been finalised, then you are asked whether you are sure 
when the changes come to be saved. 
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 Asset Code This code is generated automatically if this is selected on the Periods screen. But 
it can always be overridden on this screen. 

 Asset Name The name of the asset. 

 Asset class The Asset Class the asset belongs to. This can be changed, but not if it affects a 
finalised period. 

 Depreciation Start Date The date the depreciation calculation starts from. It is usually left 
blank. If so, the depreciation calculation starts from the date of the first addition or, if the 
option is set to Calculate a Full Period's Depreciation in the Period of Acquisition on the 
Periods screen, it starts from the year start date. If depreciation should start from a different 
date then the Depreciation Start Date can be specified. The Depreciation Start Date cannot 
be before the date of the first addition. It is sometimes useful when a piece of plant and 
machinery is being bought and assembled in stages and is only brought into use at the end of 
this process. 

 Date Acquired and Disposed These fields are  set by the system from the Asset Movements 
for Cost B/Fwd, Additions and Disposals. 

 Original Depreciation Method The Original Depreciation Method is used unless there is an 
Asset Movement for a Change of Method, in which case the new method is used from the 
date of the Change of Method. The Depreciation Method cannot be changed if it would 
affect a finalised period. The Depreciation Method and Percentage default to those on the 
Asset Class, but can be overridden. The Residual Value is the value down to which you wish 
to depreciate the asset. It defaults to 0 if the Depreciation Method is Straight Line, or 1 if the 
Depreciation Method is Reducing Balance. 

 History The History shows all Asset Movements entered on the asset, whether in the current 
period or in a past or future period. Click on the Movement Type to drill into the Asset 
Movement. 

Note 

 If the Depreciation Method is set to Reducing Balance the Residual Value cannot be less than 
£1. Otherwise it could take an extremely long time to depreciate to the Residual Value. 

Ribbon  

The options are: 

 Export Export the Asset to Excel, from where it can be printed if required. 

 Delete Asset An Asset can only be deleted if it has no movements in any period. 

 New Asset Movement Creates a new asset movement. 

Asset Movement 

The Asset Movement screen shows a single asset transaction. 
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Asset Movements are stored in the Fixed Asset Register and are not linked to transactions in CCH 
Accounts Production. For instance, you might take on a client's trial balance with all entries dated 
at the year end, but there could be several Asset Movements in the Fixed Asset Register that 
represent the Motor Vehicles Additions account and they could be dated on the actual Addition 
date rather than the year end date. 

The fields are: 

 Movement There are five Movement types which are used as follows: 

 Cost B/Fwd Used when the cost and accumulated depreciation are being taken on for an 
asset at the year start date. A Cost B/Fwd should not be dated after the year start date. 
Otherwise, the Cost B/Fwd nominal account is unlikely to reconcile with the Fixed Asset 
Register balance for the Cost B/Fwd. 

 Addition Used for posting Additions to an asset, either an original purchase or an 
addition to the original cost. 

 Adjustment Used when the accumulated cost or depreciation needs to be adjusted, e.g. 
for an Impairment posting or for transferring part of the cost and depreciation to 
another asset. On the Asset Summary and Asset Class screens, the cost of Adjustments is 
included in the figure for Additions and the depreciation on Adjustments is included in 
the figure for the Depreciation Charge for the year. 

 Revaluation Used to revalue an asset. The Value is the difference between the new 
valuation and the original cost. 

 Disposal Used for selling an asset. There can only be a single Disposal movement for an 
asset and it must be the last entry on the asset's history. 

 Change of Method A Change of Method movement is used to change the depreciation 
method or rate from a particular date. It has no Acquisition Date, Value or Depreciation 
fields and is described in a separate section below. 

 Date The date of the movement. Movements cannot be posted to a finalised period and a 
warning is given if a posting is made to a prior period that is not finalised. Movements dated 
after the year end are allowed, but ignored until you roll forward into the later year. 
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 Acquisition date This date is only enabled for Cost B/Fwd movements. It allows you to 
record the original acquisition date of an asset even if it is being taken on using a Cost 
B/Fwd. 

 Description A description for the movement. 

 Value For Disposals this is the disposal proceeds; for other movements it is the cost amount. 

 Depreciation Only enabled for Cost B/Fwd and Adjustment entries. The amount of the 
depreciation b/fwd or depreciation adjustment. 

Notes 

 Difference from N/L This box appears next to the Value and Depreciation fields. It is 
effectively a cut-down version of the Reconciliation. It shows the amount that should be 
posted to remove the difference with the nominal ledger. What appears there depends on 
the Movement Type: 

 Cost B/Fwd The box shows the Cost B/Fwd and Depreciation B/Fwd on the nominal 
accounts for this Asset Class less the Cost B/Fwd and Depreciation B/Fwd calculated in 
the FAR. 

 Addition The box shows the Additions on the nominal account less the Additions on the 
FAR. 

 Adjustment The box does not appear. 

 Revaluation The box shows the Cost Revaluation on the nominal account less the Cost 
Revaluation on the FAR. 

 Disposal The box shows the disposal proceeds on the nominal ledger less the disposal 
proceeds on the FAR. The disposal proceeds on the nominal ledger are calculated as the 
sum of the manual entries on the P/L on Disposal account, i.e. excluding any cost and 
depreciation eliminated on disposal that was automatically posted there by the FAR. 

Ribbon  

The options are: 

 Delete Asset Movement An asset movement cannot be deleted if it affects a finalised 
period. 

Change of Method Movement 

A Change of Method movement is used when the depreciation method or rate needs to be 
changed from a particular date. This happens in the following circumstances: 

 When a review of the remaining life of assets suggests that a change in the depreciation rate 
is required. This often happens in conjunction with a revaluation. 

 When a change of accounting policy requires a change in how depreciation is calculated. 

Depreciation is calculated using the asset’s Original Depreciation Method up until the Change of 
Method and then using the new method from that date onwards. 

The fields on a Change of Method movement are: 

 Date The date from which the new depreciation method or rate will take effect. This is 
usually the first or last day of the accounting period. 

 Depreciation Method (None/Straight Line/Reducing Balance). The new depreciation 
method. 
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 Percentage The new depreciation percentage. 

 Residual value The new residual value 

 

Export 

The Export screen is accessed through File > Open > Import/Export. It is used to export Fixed 
Asset Register data for a client (or clients) so that it can be imported on another Central 
database. This could be used to send the data to another office. 

The Export screen leads you through a wizard with several screens. 

Select Client(s) to Export  

 A Search control at the top of the screen allows you to limit the clients displayed to those 
matching part of a Code or Name 

 Click the columns headings to sort by Code or Name. 

 Tick the clients you wish to export. 

 Click Next to move to the next screen. 

Select Export File  

 Click Browse to choose the file name where you want to save the data. (Clicking the link 
does exactly the same). 

 Click Next to move to the next screen. 

Exporting  

 This screen shows the progress of the export. 

Export Complete  

 This screens notifies you of success or failure. 

 Click Finish to exit the wizard. 

Import 

The Import screen is accessed through File > Open > Import/Export. It is used to import Fixed 
Asset Register data for a client (or clients) that was previously exported. 

Notes 

 If the client already exists in the destination database, only its Fixed Asset Register data is 
overwritten on import. Data relating to other products, e.g. CCH Accounts Production, is 
untouched. 

 The FAR export file contains the FAR data and a little data about the client. If the client does 
not already exist in the destination database, then the client data is used to create it before 
the FAR data is imported. But the new client has no Accounting Periods in CCH Accounts 
Production, so there is no way to access the FAR data! There are two solutions to this: 

 Export the CCH Accounts Production data and send it along with the FAR export file. 
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 Create an Accounting Period in the destination database after the FAR data has been 
imported. (It is not necessary to create all the Accounting Periods). In this case, you will 
have access to the FAR data but not to the nominal ledger data that is related to it. This 
may be adequate for some purposes. For instance, you could correct the FAR data, 
export it again and send it back to the original sender. 

The Import screen leads you through a wizard with several screens. 

Select the Source of the Import  

 Click here to select the file to import Use this link to browse to the import file 

 Click Next to move to the next screen. 

Select data to import  

The clients that are contained in the import file are listed. You are warned if any of them already 
exist in the Central database. 

 If you do not wish to import any of the clients in the file then untick them from the list. 

 Click Next to move to the next screen. 

Importing Data  

 This screen shows the progress of the import. 

Import Complete  

 This screens notifies you of success or failure. 

 Click Finish to exit the wizard. 
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FAQs 

What are the main system limitations?  

The main limitations of Fixed Asset Register are as follows:  

 The Fixed Asset Register requires the user to be licensed for CCH Accounts Production. 

 The Fixed Asset Register currently ignores Reporting Periods if they are set up in Accounts 
Production. All depreciation postings are dated on the last day of the Accounting Period. 

 The Fixed Asset Register lacks a concept of Location Codes to identify where an asset is 
located. It also ignores Accounts Production's Divisions if they are being used for this 
purpose. 

 Fixed Asset Register data is not included when a client is "travelled out" of Accounts 
Production or Corporation Tax. Also you cannot create a Fixed Asset Register on a travelled 
out client. 

 Fixed Asset Register fields are not available within CCH Reporting or SmartReports. 

No Depreciation Calculated  

If you enter a Bank Payment to buy an asset and analyse it in the Fixed Asset Register, sometimes 
no depreciation is calculated. The most likely reason for this is that: 

 the entry is dated on the last day of the year (which is the default date), and 

 the option to Calculate a Full Period's Depreciation in the Period of Acquisition?  is 
unticked 

No depreciation is due in this situation. 

Why does the system tell me I have a gap between 
Accounting Periods? 

You are not allowed into the Fixed Asset Register if there is a gap between accounting periods in 
AP. This can happen if the year end date of one year has been edited without editing the year 
start date of the next year. This usually happens when there is a leap year: 

 Suppose we have a year ended 28/02/2015. 

 It is rolled forward and AP creates a year ended 28/02/2016. 

 Accounts are produced and the client is rolled forward again. 

 The roll forward creates a year from 29/02/2016 to 28/02/2016. 

 This looks somewhat strange, so the user edits the year start date to 01/03/2016. 

This leaves a one day gap between the year ended 28/02/2016 and the year started 01/03/2016. 
You are then unable to access the Fixed Asset Register and receive the message that “There is a 
gap between the Accounting Periods after the period ended 28/02/2016. Edit the period dates in 
Statutory Database before continuing to Fixed Asset Register.” To resolve this, go into the earlier 
period, select Statutory Database > General > General information and edit the period end 
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date to remove the gap. You can now go back to the current period and go into the Fixed Asset 
Register. 

Notes 

 More rarely, you may see a similar message if the accounting periods overlap. The solution is 
the same. The Fixed Asset Register requires that AP uses a sequence of accounting periods 
with no gaps and no overlaps so that it knows when to calculate the cost and depreciation 
brought forward balances. 

 You may also see a message “Please access Fixed Asset Register from the corresponding 
FRS102 accounting period”. This happens if you have converted a client from UK GAAP to 
FRS102. AP creates comparative and precomparative FRS102 periods. If you try to access the 
Fixed Asset Register from the old UK GAAP comparative or precomparative period, you are 
asked to access it from the equivalent FRS102 period.  

What are Breadcrumbs?  

Breadcrumbs are the term given to the navigation bar shown along the top of the Fixed Asset 
Register screens. 

 

The Breadcrumbs show the history of the screens that you pass through as you drill down into 
the Fixed Asset Register. If you hover over one of the blue labels in the list then it is underlined to 
indicate that it is a link. Clicking the link takes you to the relevant screen. 

Notes 

 The first label in the Breadcrumbs also shows the client code and the current year end. 

 The last label in the list is disabled as it is the current screen and no link is required. 

Can I override the depreciation calculated on an asset? 

You cannot change the system's calculation of depreciation on an asset. But you can post an 
Adjustment entry that adjusts the calculated depreciation. For instance, if the system 
calculates £10 depreciation on an asset and you wish it to be £9, then you can post an 
Adjustment dated on the last day of the year with Depreciation set to -1. 

How do I set up an asset with components with different 
useful lives?  

The FAR does not support subassets. So if an asset is made up of component assets then each 
needs to be set up as a separate asset. However the Asset code can be quite long. So they could 
be indicated with codes such as PM00002/01, PM00002/02 and so on. 

How do I handle a revaluation of an asset? 

This often occurs with Freehold Property. This is performed using a Revaluation Movement. 

How do I handle a change in the useful life of an asset? 

An example is an extension of a lease. This is performed using a Change of Method Movement.  
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How do I set up an Asset Class with 3 nominals for 
Depreciation Cost of Sales, Distribution 
Costs and  Administrative Expenses? 

The FRS102 chart of accounts has accounts for "Depreciation - Cost of Sales", "Depreciation - 
Distribution Costs" and "Depreciation - Administrative Expense". You can only specify one 
Depreciation Charge account  on an Asset Class. How can you get the correct analysis in the 
nominal ledger? 

Suppose you are setting up an Asset Class for Motor Vehicles. There are two approaches: 

1. You could set up separate Asset Classes for "Motor Vehicles - Cost of Sales",  "Motor Vehicles 
- Distribution Costs" and "Motor Vehicles - Administrative Expense". However most nominal 
accounts would be the same on all 3 of these Asset Classes. 

2. It is usually simpler to set up just one Asset Class for "Motor Vehicles" and post all 
depreciation to "Depreciation - Administrative Expense". At the end of the year you can 
then journal out a reasonable proportion of the total Depreciation Charge to the other two 
Depreciation accounts. 

If you adopt the second approach, the balance on  "Depreciation - Administrative Expense" does 
not agree with the FAR depreciation charge for the year. This is partly why the posting accounts, 
such as Depreciation Charge, are not reconciled on the Asset Class screen. 

Why is there no Master Asset Class for Investment 
Properties?  

Under FRS102 Investment Properties have their own note in the accounts, separate from 
Tangible Fixed Assets. They are also regularly revalued to fair value and no depreciation is 
calculated on them. So it is probably more convenient to keep a record of Investment Properties 
outside the Fixed Asset Register and no Master Asset Class has been provided for them. 

How do I enter Part Disposals? 

The Fixed Asset Register does not hold a quantity balance for each asset. Suppose you have an 
asset called “6 chairs” and you wish to sell 2 of them. You should proceed as follows: 

 Create a new asset called “2 chairs”. Edit the name of the old asset from “6 chairs” to “4 
chairs”. 

 In the Fixed Asset Register, enter an Adjustment on the old asset of 1/3 of the cost and 
depreciation, dated on the first day of the year. The balances on this entry will both be 
negative. 

 Enter an Adjustment on the new asset with the same cost, depreciation and date, but this 
time with positive balances. This transfers the cost and depreciation of 2 chairs to the new 
asset without any effect on the nominal ledger. 

 Now sell the new asset in the usual way, starting from Accounts Production. 

Note that the above procedure does not affect the balances in the previous year. But if a Fixed 
Asset Register report is run in the previous year then the description of the asset appears as "4 
chairs", even though 6 chairs were held at that time. 
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When the accounts are rolled forward, does the FAR get 
locked down so that the figures do not change? 

The previous year’s FAR is not locked down unless you select Finalise Accounts in Accounts 
Production. If you don’t select Finalise Accounts, then you are able to make prior year entries: 

 If you go into the prior year in Accounts Production and then go into the FAR and make an 
entry dated in that year, the system accepts it without any warning. It also updates the 
opening cost and depreciation in the next year. But it doesn’t update the nominal ledger in 
the next year. So your opening cost and depreciation will not reconcile with the nominal 
balances in the next year. 

 If you go into the current year in Accounts Production and then go into the FAR and make an 
entry dated before the year start date, the system warns “This movement will affect earlier 
Accounting Periods. Are you sure?” 

What would be “best practice” for the whole process of 
importing from VAP/Excel? 

When importing from VAP/Excel, you should normally wait until you’ve rolled forward a year, 
then export the balances and import them as opening balances into the new year in FAR. 

You can not do this mid-year, as Import from VAP will automatically assign the year start date to 
the imported balances. But if you have started the year, you could proceed as follows: 

 Reverse out any depreciation postings to date as well as any journals eliminating cost and 
depreciation on disposal. 

 Import the FAR assets and balances at the year start date. 

 In the FAR, add any asset movements corresponding to entries that have already been 
entered in the nominal ledger 

 Calculate Depreciation to regenerate the depreciation postings. 

It is doubtful if you would want to do this if many fixed asset entries had already been made in 
Accounts Production, but it could be useful in some cases. 

How do I treat grant-funded assets or assets bought under 
finance? 

If the asset is grant-funded or bought on finance, it is shown in the fixed asset note in the 
accounts in the usual way. The cost of the addition as entered in the FAR is brought into 
Corporation Tax. The user can then decide on the tax treatment. It could be non-qualifying, or it 
could qualify but at a different tax value. Either of these scenarios can be specified in Corporation 
Tax, just as they are for an entry made manually. 
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Reference 

Usage of Asset Class Nominals 

The Asset Classes are set up on the Set up screen. This topic describes the usage of the Asset 
Class nominals in more detail. The Asset Class nominal accounts have two functions: 

 Trigger Accounts The nominal accounts that act as control accounts for the Fixed Asset 
Register. When postings are made to these accounts in CCH Accounts Production, the system 
asks "Analyse in Fixed Asset Register?" so that the posting can be broken down into its 
effects on individual assets. We call these accounts "trigger accounts" as they act as a trigger 
for the Fixed Asset Register to spring into action. 

 Posting Account The nominal accounts that are used for automatic depreciation postings by 
the Fixed Asset Register. 

Most nominal accounts act as either Trigger Accounts or Posting Accounts. The P/L on Disposals 
account acts as both. The different nominal accounts and their use are shown below. 

  

Nominal account Trigger Account (Yes/No) Posting 

Accounts (Yes/No) 

Cost B/Fwd Yes. Taking on an asset balance 

and its depreciation 

No 

Additions Yes. Purchasing a new asset, or 

adding cost to an existing asset 

No 

Revaluation Yes. Revaluing an existing asset. No 

Cost of disposals No Yes. Cost eliminated on the 

disposal of an asset. 

Depreciation B/Fwd Yes. Same as Cost B/Fwd No 

Depreciation charge 

(B/Sheet) 

No Yes. The depreciation charged 

in the year. 

Depreciation 

on revaluation 

No Yes. The depreciation to date 

eliminated as a result of a 

revaluation. 

Depreciation on disposals No Yes. The depreciation 

eliminated on disposal. 

Revaluation reserve No Yes. The depreciation to date 

eliminated as a result of a 

revaluation. 
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Depreciation charge (P/L) No Yes. The depreciation charged 

in the year. 

P/L on disposals Yes. Posting the disposal 

proceeds on an asset sale 

Yes. The cost and 

depreciation eliminated on 

disposal 

  

Differences Between Importing into Tax from AP and the FAR 

When data is imported into Tax, i.e. either Corporation Tax or Personal Tax, the balances come 
from Accounts Production, while the Additions and Disposals come from the Fixed Asset Register. 
But the link between the Fixed Asset Register and Tax is a little different from the link between 
CCH Accounts Production and Tax. This topic explains the differences. 

The Tax Links screen appears as follows for Corporation Tax: 

 

It appears as follows for Personal Tax: 
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The basic difference is that the Fixed Asset Register link can be switched on or off. When it is off, 
we say that the Fixed Asset Register data is “unlinked”. The Accounts Production link is always on, 
and you just control whether it should run automatically or not. With Corporaton Tax, if you set 
the link to run automatically, you can also specify which balances are to be imported. This basic 
difference has three effects. 

Effect of Enabled Links settings 

If Update automatically is unticked for Accounts Production, then there is a difference in the 
function of the Enabled Links setting used to link the Fixed Asset Register. 

 Corporation Tax. For Corporation Tax, this setting is CCH Accounts Production link - 

Balance sheet. 

 CCH Fixed Asset Register This setting must always be ticked to import Fixed Asset 
Register data. Otherwise the Fixed Asset Register is “unlinked”. 

 CCH Accounts Production The Enabled Links setting for  CCH Accounts Production link 

- Balance sheet does not affect what data is imported from AP when Update 

automatically is unticked. The AP Balance Sheet data is always imported. The Enabled 

Links settings only control what data is imported if Update automatically is ticked. 

 Personal Tax. For Personal Tax, the setting to link the Fixed Asset Register is called CCH 

Accounts Production link. 

 CCH Fixed Asset Register This setting must always be ticked to import Fixed Asset 
Register data. Otherwise the Fixed Asset Register is “unlinked”. 

 CCH Accounts Production The Enabled Links setting for CCH Accounts Production link 
setting does not affect whether you can import data from AP when Update 

automatically is unticked. The AP balances are always imported. So the setting does not 
“enable the link” as its title suggests; it actually affects whether a warning is displayed in 
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Errors and Exceptions that data is ready to import. (However the settings for CCH Trust 

and Estate link and the CCH Partnership link do enable their respective links). 

Whether data can be edited in Tax after importing it 

 CCH Fixed Asset Register Additions and Disposals are imported from the Fixed Asset 
Register. Some fields on these records exist in the FAR; others do not. Fields imported 
from the FAR cannot be edited in Tax, although you can edit the other fields. The fields 
that are not editable are greyed out. If you edit one of the editable fields and then 
update Tax a second time, the manual edits are retained. 

 CCH Accounts Production Data imported from Accounts Production can be edited in 
Tax. This means that if Tax is updated a second time, manual edits are lost. 

Whether data can be "unlinked" 

 CCH Fixed Asset Register You can unlink the Fixed Asset Register from Tax. For 
Corporation Tax you untick the CCH Accounts Production link - Balance sheet setting; 
for Personal Tax you untick the CCH Accounts Production link setting. When the Fixed 
Asset Register data is unlinked, the FAR fields on Additions and Disposals that could not 
be edited before become editable and, if Tax is updated a second time, no further data is 
imported from the FAR. So any manual changes that are made are retained. 

 CCH Accounts Production has no concept of "unlinking". If you export the data from 
Accounts Production and import it into Tax, it will always overwrite any manual changes 
in Tax. 

Prior Period Entries 

The Fixed Asset Register allows Asset Movements to be made in a prior period unless it has been 
"finalised" in CCH Accounts Production. This follows the approach of  Accounts Production which 
allows nominal entries to be made in prior periods. The Fixed Asset Register also allows changes 
to be made that affect the depreciation calculation for prior periods without posting an Asset 
Movement. An example is changing the setting for Calculate a Full Period's Depreciation in the 

Period of Acquisition? Although these changes are permitted, it is important that you 
understand the effect of making them. 

If you make a change that affects a prior period, depreciation is recalculated immediately in the 
prior period and in all subsequent periods. If you then go into the current period, you find that 
the Cost and Depreciation B/Fwd in the Fixed Asset Register have changed. But the Cost and 
Depreciation B/Fwd on the nominal ledger do not change automatically. This creates a difference 
between the Fixed Asset Register and the nominal ledger that appears on the Reconciliation 
screen. You may need to make entries in the nominal ledger to bring the nominal ledger into 
agreement with the Fixed Asset Register. 

If a prior period adjustment is not required, a simpler alternative may be to only make the change 
in the current period, perhaps with an Adjustment entry. 

Task Permissions 

Task Permissions are used by system administrators to control which users have access to which 
functions. The Fixed Asset Register Task Permissions are accessed as follows. 

 They are set up in File > Maintenance > Security > Task Permissions. 

 Set the Product to Accounts Production. 
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 The Group represents a set of all the permissions required by Employees performing a 
particular role. For instance, in a new Central database, CCH includes groups for Accounts 

administrator, Tax operator etc, although users can create their own. 

 Groups are properly called Security Groups. 

 A Security Group such as Tax operator not only includes permissions relating to Personal 
Tax. It includes permissions for all products. In particular, the Tax operator Security 
Group includes some permissions for Central, as a tax operator would need some of 
these. 

 An Employee who performs multiple roles may be in more than one Security Group. If an 
Employee has both Accounts Operator permissions and Tax Operator permissions, they 
are allowed to perform the functions that are enabled in either Security Group. 

 Employees are allocated to Security Groups by opening the Employee and selecting the 
Security Groups tab. 

 Task Permissions are categorised by Group Description. (The Group Description is 
unconnected with the Security Group just mentioned.) For Product Accounts Production, the 
available Group Descriptions are Business Type, Client, Maintenance, Other and Portal. In 
the screenshot below, the user has selected the Group Description as Client and the list of 
available permissions is shown. 

 

 In the screenshot below, the user has scrolled down, making some Fixed Asset Register Task 
Permissions visible. 
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Task Permissions are identified by a Permission Description such as “#Client #Fixed Asset Register 
#Can Delete Assets”  as shown above. This name has 3 parts, separated by hash characters. The 
first part of the Permission Description repeats the Group Description. But apart from that, the 
format of the name is just to make it understandable to the user and has no meaning to the 
application. Within the Fixed Asset Register, the following permissions are available: 

Permission Name Description 

#Maintenance #Open Master Asset Class You can open the Master Asset Classes screen 
to view or edit the Master Asset Classes. 
(Master Asset Classes cannot be edited if they 
belong to a published Masterpack.) 

#Client #Fixed Asset Register #Can Open Fixed 
Asset Register 

You can access the Fixed Asset Register. 
Without this permission, the Fixed Asset 
Register icon is disabled. 

#Client #Fixed Asset Register #Can Create 
New Register 

You can create a Fixed Asset Register on a 
client that has never previously had one. You 
do this by clicking the Fixed Asset Register 
icon in Accounts Production and selecting the 
initial defaults such as “Generate Asset Codes 
Automatically?” 

#Client #Fixed Asset Register #Can Import 
From Excel 

Enables the icon to Import from Excel. 

#Client #Fixed Asset Register #Can Import 
From VAP 

Enables the icon to Import from VAP. This 
permission should be enabled with caution 
(see Notes below).  

#Client #Fixed Asset Register #Can Delete 
Asset Movements 

Enables the Delete icon for an Asset 
Movement. 
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#Client #Fixed Asset Register #Can Delete 
Assets 

Enables the Delete icon for an Asset. But you 
can only delete an asset if it contains no asset 
movements.  

#Client #Fixed Asset Register #Can Delete 
Asset Classes 

Enables the Delete key for an Asset Class. But 
you can only delete an asset class if it contains 
no assets. 

Notes 

 All the Task Permissions are under the Client Group Description apart from the first one 
which is under Maintenance because it is accessed through the Maintenance menu. 

 Care should be taken enabling the permission to Import from VAP. Importing from VAP on a 
new Fixed Asset Register is safe enough. But if a user does it on a FAR client that contains 
data, then all the existing FAR data for that client is deleted (after the user is warned). So this 
setting allows a user to delete all the data on a FAR client. 

Applying Task Permissions 

After licensing Fixed Asset Register, the FAR task permissions are switched off. So you need to 
enable the permissions for certain Security Groups. For instance, if you are comfortable with 
Accounts operators deleting data, and you are using the default CCH Security Groups, then you 
might set: 

 Accounts Operator has all Fixed Asset permissions apart from “Open Master Asset Class” 
and “Can Import From VAP”. 

 Accounts Administrator has all Fixed Asset permissions. 

 Tax Operator has only “Can Open Fixed Asset Register” if these users understand how the 
FAR works. 

Notes 

 If you are not happy about Accounts Operators being able to delete data you might restrict 
these rights to the Accounts Administrator. 
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Known Issues 
The Known Issues for version 2017.2 are as below, but check the online Help for updated 
information. 

ITS/56255 - The link from Fixed Asset Register to Corporation Tax does not bring in any data for 

FRS105 clients 

For 2017.1, a Schedule of Tangible Assets has been added to Accounts Production's FRS105 
Management accounts. This allows asset balances to be brought into Corporation Tax from 
Accounts Production, but no additions or disposals are brought in from the FAR. 

 


